
Overview

See also: What's new    Getting started    Keyboard shortcuts    Register    License agreement

SuperCat is a powerful, easy-to-use disk cataloging program, making it very 
simple to find files located on any disk media. 

Finding files on hard drives can be a nightmare, and finding files on removable disks 
such as CD-ROMs, Zip disks and diskettes can be impossible. SuperCat lets you catalog 
all your disks, so you'll never lose a file again.

Made for Windows 95, 98, NT (4.0 or later), Me and Windows 2000, SuperCat is an 
easy-to-use utility for cataloging, searching, and managing removable disks (diskettes, 
Zip, Jaz, SuperDisks, CD-ROM, etc.), hard drives, and network drives. 

SuperCat is easy to use for novice users and has powerful features required by 
professional users like network administrators.

These are just a few of SuperCat's powerful features:

· Easy-to-use interface
· Speed -- both cataloging and searching are extremely fast
· Fast and efficient image browser
· Catalog and search within zip-compressed archives
· Catalog entire disks or a single folder
· Built-in unzip utility
· Refine or extend your search results
· Configure your own catalog and search filters
· Search for local files (without need for updating or creating a catalog)
· Find duplicate files
· Schedule unattended, automatic updates of catalogs
· Print or save your search results
· Browse your cataloged disks
· Autocomments for hypertext documents, image files, MPEG audio files, zip files
· Reads "descript.ion" files (a standard format for file descriptions)
· Catalog unmapped network disks (Network Neighborhood interface)
· Drag and drop files from SuperCat to other programs
· Add comments to your cataloged files and catalogs
· Perform basic file operations, like rename and copy
· Support for large disks (above 2GB)
· Tray minimize

AWARDS
Microsoft & WUGNET Shareware Pick of the Week -- www.wugnet.com
ZDNet Editor's Pick -- www.hotfiles.com
BEST -- www.nonags.com
Get It! -- www.winfiles.com
Editor's Pick -- www.pcworld.com
Five stars -- www.supershareware.com
Five cows -- www.tucows.com

Registration



SuperCat is distributed as shareware. You may evaluate this software for a period of 30 
days. If you wish to use SuperCat beyond the 30-day trial period, you must register. 
You can register online, by fax, phone, or mail. We also accept purchase orders.

System requirements 
Windows 9x, NT (4.0 or later), Me or 2000.

Copyright © 1997-2001 No Nonsense Software. All rights reserved.



PrintFolder Pro

If you need to print entire SuperCat catalogs, or want to create formatted file lists 
with speed and ease, you should take a look at PrintFolder Pro, an inexpensive 
utility available from our website.

Program overview
Using Windows Explorer, printing a list of files is hard work. In fact, it's almost impossible. 
PrintFolder Pro is a fast and efficient utility that lets you print a list of files located in any 
folder -- and subfolders, too.
 
Beyond being very easy to use, you can customize file lists to fit your own preferences. List 
filenames only, or include file size, date, time, attributes, and more. 

SuperCat integration
When both programs are installed on your system, PrintFolder Pro becomes easily accessible 
from SuperCat, and vice versa. PrintFolder Pro can import and print entire SuperCat 
catalogs. 

Please visit our website for more information and a FREE trial version:

http://no-nonsense-software.com



Main toolbar

You can access several useful features through the toolbar in the main program 
window.

The following are short descriptions for each button:

Create report
Create an editable report listing all filenames in the search result file list. 

PrintFolder Pro
This button is only visible if PrintFolder Pro is installed and found on your system. Select 
any catalog file (.idx) in Catalog explorer and click on the PrintFolder button to list an 
entire catalog in PrintFolder Pro. This is useful if you want to edit, print or save an entire 
SuperCat catalog in a single operation.

Copy search results
Copy your search results to the Windows clipboard for use in other applications

Save search results
Save search results to a text file (*.txt, *.html or *.sdv). 

For the above three functions, see Reports for more information.

Unzip utility
Open the internal Unzip utility

Options
Open the Options dialog.

Filters
Open the filter editor.

Maximize search results
Maximize (and restore) the search result file list. Keyboard shortcut: F6.

Catalog folder (drop down menu)
By default, the SuperCat program folder. For network users sharing catalogs (or backup 
purposes, etc.), you can set this to be any valid folder.

If you're organizing your catalogs in several different folders, click on the arrow to see 
the history list of previously selected catalog folders. For example, this is useful if you 
keep your private catalogs in a different folder than your work catalogs. Using the 
dropdown list, you can easily change between the two.

Notice that if you change your catalog folder while you have scheduled catalogs for 
automatic updates, the Scheduled updates list will be cleared.

Browse for catalog folder
Select an existing or create a new catalog folder.

Clear catalog folder list



Clear catalog folder list of all entries, except for the one currently selected. You will be 
prompted before existing entries are lost.



What's new

Below, you'll find a list of new features and modifications included in SuperCat 4.2, 
and previous releases. 

If you have never used SuperCat before, take a look at these basic steps for creating and 
searching your catalogs. You'll be up and running in no time!

NEW FEATURES AND MODIFICATIONS
SuperCat 4.2 (April 2001)

· New search options (Search for All words, Exact phrase, Any words)
· Option to search for and list folder names only
· Completely rewritten scheduler, including many new features
· Improved search speed when using file filters
· Added option to specify Create catalog exclusions
· Improved Update catalog(s) option in Catalog explorer 
· Improved integration with PrintFolder Pro
· New option: Save window position
· Minor tweaks and fixes

VERSION HISTORY

v4.1 (March 2000) 
· Added checkboxes for easily selecting multiple files
· Added option to exclude all subfolders, in the Find duplicates Exclusion lists
· Add or edit comments for multiple files in a single operation
· Selected treeview path in Create catalog tab is retained between program sessions
· Catalog zipfile content checkbox is disabled whenever an inappropriate filter is 
selected
· Focus is set to the Find field after clicking Search, Refine or Append buttons
· Fixed program termination problem when closing Windows
· Fixed "Exception Esock error ... Successful WSAStartup not yet performed" error
· Fixed some minor problems with the image display engine
· Added "Getting started" splash screen for new users
· Fixed several minor bugs and annoyances
· Improved Help file content
· Added << and >> buttons to Help file for easy navigation 

v4.0/4.0a (January 2000) 
· Cataloging speed has been dramatically improved (since ver 3.1)
· Added fast and efficient image preview features for common file formats 
· Multiple file select: Copy, move or delete several files in a single operation
· Set font name and size for search result listview and Catalog explorer (see Options 

dialog > Display, keyboard shortcut F8)
· Change drive letter for any catalog (select properties in the Catalog explorer pop-up 

menu).
· Calculate file checksums
· Select to display file sizes as bytes or kilobytes
· Reindex (in Catalog explorer pop-up menu) has been renamed to Update catalog
· New keyboard shortcut to update selected catalog (in Catalog explorer): CTRL + F5



· New, improved dialog window for selecting destinations folder for copy and move 
operations

· New Option: "Default icons only". Use this for faster listing of files (especially exe-
files)

· New Option: Update catalogs after file operations (delete, move) You may want to 
uncheck this option if you frequently delete or move a large number of files in a single 
operation (for improved speed). If this option is NOT checked, your catalogs will NOT 
be automatically updated when you delete or move files. 

· Changed hint display times
· Changed behavior of Refine search button: If selected field (in fields dropdown menu) 

is "All" or "Filename only", refine search will search within listed filenames only. If 
selected field is "Path only" or "Comments only", then the respective field will be 
searched (within the search result listview). In previous versions, the refine button 
only searched within filenames, no matter which what was selected in the fields 
dropdown menu.

· Added option to select excluded folder(s) under Find duplicates -> Exclusions
· Find duplicates options are now retained between program sessions
· Added option "Show info tips" (in Options dialog, shortcut F8) 
· Added new option to search result popup menu: Hide non-accessible files
· Added option to disable "Prompt if disk has been cataloged before" dialog
· Added option to enable/disable file delete verification
· Added option to delete search history
· Added new option when creating new catalog: Replace existing
· Filename begins with.. Select this option to make sure that files found begins with 
· Added status animation in the Create catalog tab
· Added new option to disable the "Save changes" dialog after reindexing a disk (In 

Options dialog, keyboard shortcut F8)
· Improved report formatting
· System treeview in Create catalog tab is now correctly updated when changing CD-

ROM's, etc.

v3.1 and v3.1a (September/October 1999):
· Added Select Drive feature
· Added new toolbar in main program window
· Moved the Indexfile folder dropdown menu from Options to main program window
· Moved the browse catalog treeview to main program window (Explorer style)
· Browse catalog treeview is now sorted alphabetically
· Added option to maximize the Search results file list (shortcut F6)
· Added shortcut to maximize catalog library view (F7)
· Added shortcut for sorting filenames alphabetically (F11)
· Added option to automatically sort search results alphabetically
· Esc key now closes (and discards) various properties and options dialogs
· Added a warning when assigning removable disks to the scheduler
· Removed Import and Export options from the Catalog library popup menu
· Improved speed when clearing the search result file list
· Added autocomments for DHTML (Options -> Autocomments -> Hypertext 
documents)
· Removed the Delete folder button from the Browse for indexfile folder dialog
· Create HTML-formatted list of all cataloged disks (catalog library pop-up menu)
· Catalogs in the Catalog library are now sorted alphabetically by default
· Fixed problem with autocomments not working for long filenames in descript.ion files
· Fixed access violation when trying to browse certain indexfiles



· Fixed problems when adding catalogs to scheduler using the catalog library popup 
menu
· Fixed keyboard shortcut for initializing a search (ALT+S)
· Fixed problem when refreshing search result using keyboard shortcut F5
· Fixed access violation when reindexing a disk while browsing
· Fixed problem when unzipping files to disk root directory (e.g. C:\)

v3.01 (May 1999):
· Fixed problem when navigating drives and folders with keyboard (Create catalog tab). 

Removed error message when selecting an unavailable disk.
· In previous versions, SuperCat always ejected the first (default) CD-ROM, even if 

another CD was cataloged (when "Eject CD" was selected in the Create catalog tab). 
The program now ejects the correct CD.

· Some users reported an error "Cannot create file disk.dat" when trying to delete 
catalogs from the Catalog library. This problem has been fixed.

· Fixed problems with reindexing (manually or through the scheduler) catalogs of 
unmapped network disks

· Fixed a problem ('n/a' is not a valid integer value) when trying to access catalog 
properties for unmapped network disks

· Fixed a bug that caused an Access Violation when trying to browse catalogs containing 
filenames that included special escape characters

· Added a new option to the Catalog library pop-up menu: Create list. This generates a 
simple list of all you cataloged disks.

· Added formatting buttons to the report editor. 

v3.0:
· Catalog and search inside zip-compressed archives
· Built-in unzip utility
· Browse your cataloged disks
· Refine or extend your search results
· Improved filter editor (unlimited filters)
· Find duplicates
· Schedule catalogs for unattended, automatic updates
· Added autocomments for MPEG audio files
· Catalog unmapped network disks (Network Neighborhood interface)
· Drag and drop files from SuperCat to other programs
· File comments limited to 500 characters (was 100 in previous versions)
· Tray minimize
· New 
· Added indexfile folder history list (Options)
· Added option to ignore max hits setting
· Improved automatic naming of indexfiles
· Numerous fixes and modifications

v2.1 (September 1998):
· Disk "Reindex" and "Remove orphans" options
· Delete, Copy, Move and Rename files 
· Search history list
· Autocomments for image-, zip- and HTML files 
· Support for 4DOS file descriptions



· Search only a specific indexfile
· User-configurable indexfile folder
· Save results as HTML or semicolon-separated, database-ready text files
· Configure your own index and search filters
· Options tab for fast access to many new configuration setting
· Import and export indexfiles
· Drive icons in the Catalog library
· Improved indexing speed 
· Catalog all folders, including hidden and system directories

v2.0/2.0a (May 1998)

· Report Editor. Copy, save or print your search results
· File comments. Add your own easy-to-remember comments to any indexed file
· Search filter. Search for specific file types
· Toolbar for easy access to view and report options
· Optional views for the search result window. Choose between detailed view, list or 
large icons
· Show gridlines in the search result window
· Added new functions and items to popup-menus
· Several new keyboard shortcuts
· SuperCat now reports total file size of all files in the search result window
· Checkbox to disable the "Returned maximum number of hits" message
· Indexfiles are deleted to recycle bin
· Maximize window option enabled
· Saves column and window settings between sessions
· SuperCat no longer reports negative values to total and free disk space for disks 
larger than 2GB
· Improved program display when used with various screen resolutions and large fonts
· Improved speed of the index library, resulting in overall performance increase
· Improved interface

v1.0 (January 1998)
First program release.



License Agreement

See also: Register

You should carefully read the following terms and conditions before using this 
software. Your use of this software indicates your acceptance of this license 
agreement.

SuperCat is distributed as shareware.

You may evaluate SuperCat for a period of 30 days. If you wish to use the software 
beyond the 30-day trial period, you must register. A single-user license is USD 25 
(subject to change without notice). Registration benefits includes future upgrades and 
free email support.

You can register online, by fax, phone, or mail. We also accept purchase orders.

The unregistered trial version is not crippled in any way, except that it will show a 
friendly registration reminder when you exit the program. Some program features will 
be limited when the 30-day trial period has expired. 

You are permitted and encouraged to distribute copies of the original, unmodified, zip-
compressed SuperCat archive. However, you are not permitted to charge anything for 
doing so. Computer magazines are allowed to distribute the unmodified trial version on 
cover disks, etc., without having to contact No Nonsense Software in advance.

When registering SuperCat, you will receive an email with registration instructions.

You may not reverse engineer, decompile or disassemble this software product.

You may not rent, lease or lend the software product.

A valid single-user license grants you the following rights:
You may install and use as many copies of SuperCat as you have purchased licenses for. 
You may also install and use an additional copy on a personal portable computer. 

Site licenses
With a site license, SuperCat may be used simultaneously on the number of systems 
you have purchased a license for. Contact us for further information. We will discuss 
special discounts and arrangements as needed. Send us an e-mail at feedback@no-
nonsense-software.com

DISCLAIMER
THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT WARRANTIES AS TO PERFORMANCE 
OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. 
NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Copyright © 1997-2001 No Nonsense Software. All rights reserved.



Shareware

All text within this topic is provided as general information only. For specific 
information on this particular software product, read the Software license 
agreement.

What is shareware? 
Shareware is a marketing method, not a type of software or even strictly a distribution 
method. When software is marketed through normal retail channels, you're forced to 
pay for the product before you've even seen it. The shareware marketing method lets 
you try a program before you buy it. Since you've tried the program, you know whether 
it will meet your needs before you pay for it. A shareware program is just like a 
program you find in major stores, catalogs, and other places where software is 
purchased; except you get to use it on your own computer before paying for it. 

Why pay for software I already have? 
Basically, for the same reason you should pay for any program: Because it's the honest 
thing to do. Shareware is commercial software, fully protected by copyright laws. Like 
other business owners, shareware authors expect to earn money for making their 
software available. In addition, by paying, you may then be entitled to additional 
functions, removal of time-limiting or limits on use, removal of so-called "nag" screens, 
and other things as defined in the documentation provided by the program's author. 

But, didn't I already pay for the program when I bought the disk?
No. Shareware vendors distribute shareware evaluation versions of programs. They 
charge a small fee for the costs of disk duplication, and advertising, plus a small profit. 
The money paid to a shareware vendor does not go to the author. This is also true for 
shareware CD-ROMs which typically contain hundreds of evaluation versions. These may 
be sold directly by vendors, distributed with magazines, sold as an addition to a book, 
or otherwise distributed to you. 

What if I don't like the evaluation version? 
That's simple: Just stop using it, and remove it from your computer system. Many 
shareware authors even provide a simple "uninstall" feature that makes this easy. 
You've lost nothing but the small cost of obtaining the evaluation version and the time 
involved for the evaluation. 

What about computer viruses? 
The shareware industry has an excellent track record providing products that have been 
checked thoroughly for viruses. Shareware authors, bulletin board and on-line service 
operators, as well as disk vendors, carefully scan programs for viruses before offering 
them to consumers; so, a shareware program will often have more checks made on it 
than regular commercial software. Also, the compressed formats used to transmit most 
shareware programs tend to offer additional protection because each compressed file 
comes with its own safety checksum to detect tampering. 

Why do authors use shareware to distribute their programs? 
Basically, it's efficient. Costs are generally less than for software sold through traditional 
channels. Lower operating costs mean shareware authors can concentrate on writing 
great programs, while often charging users less. Shareware also allows authors to retain 
complete control. Microsoft and Netscape are just two software companies that have 
recognized benefits of "try before buy" distribution. 



How can I legally distribute someone else's shareware? 
You'll need to check each program you wish to distribute for any distribution restrictions 
that the author may have placed on their software. Check the program documentation 
and/or files with names like DISTRIB.TXT, VENDOR.TXT, and VENDINFO.DIZ for 
restrictions. When in doubt, you should contact the author for permission - failing to do 
so could leave you liable for copyright infringement. COMMON MISTAKE - Some folks 
think that if they purchase a CD-ROM collection of software that they may feel free to 
distribute that software; or, if they've downloaded a copy from the Internet, that they 
can sell copies if they wish. Unfortunately these conclusions are not true. A number of 
software publishers are using exclusive distribution licenses to allow distribution of their 
software; violating one of these licenses could result in a very expensive lesson when 
you're sued for your actions. Better safe than sorry! 

Which programming language is used to produce quality shareware software? 
There are a large number of programming languages, and your choice will depend 
greatly on what kind of prior programming experience you have and what kind of 
software you're interested in producing. In addition, there's a lot more involved in 
writing good shareware than just writing software. You need to consider marketing 
plans, software design, registration incentives, press releases, and publicity - and more. 
Finally, the type of computer and operating system you're writing software for will have 
a great effect on the available tools and languages. 

How many people register shareware? 
There are no real statistics on registrations - just guesses. There's really no way of even 
knowing total download counts, and there's absolutely no way of knowing how many 
people who download a program use it past a preliminary evaluation.

Additionally, registration rates probably vary wildly by category of program. Business-
application registrations are probably pretty high, percentage-wise, because people who 
rely on software to make money are more likely to feel the need for support from the 
author. Small games and utilities are everywhere and are easily replaceable.

Nag screens and other limitations might increase registrations on smaller programs, but 
a look at history shows every program that became a "standard of the industry" has 
used no registration incentives designed to annoy the user. These include WinZip, 
PKZip, AsEasyAs, Procomm, Telix, and the trend goes back to even PC-Talk, PC-File, and 
PC-Write. These are the real money-makers (along with major games like Doom, of 
course).

So what's the registration percentage? It might be as low as 1% for some programs and 
higher than 50% for others. But that's just a guess.

Can I just keep using software that's outdated? 
No. There's a specific procedure that an author must follow to abandon their copyright, 
and if they haven't done so, then the shareware continues to be copyrighted. It's also 
possible that the software has been sold to another shareware business, and a new 
company may be actively supporting it. Even if the author has actually gone out of 
business, why do you want to use an unsupported program? What are you going to do if 
it crashes or if you need changes? Where are you going to find support and upgrades? 
How will you get newer versions to support new operating systems and features? You'll 
be doing yourself a favor if you find a newer program that you like, instead, which is 
still actively supported. 



Where can I find shareware on the Internet?
There are many great shareware sources easily available on the World Wide Web. Some 
of our own favorites are www.hotfiles.com, www.webattack.com and 
www.download.com.



Support and feedback

As a registered SuperCat user, you can always contact us for fast, no-nonsense help and 
support. 

Please send all questions through our website feedback page, or by email to 
feedback@no-nonsense-software.com.

Be sure to include your name and a valid email address. You will receive a reply as soon 
as possible. Also, feel free to send us any feedback, comments and suggest features 
you'd like to see in future SuperCat versions.



«Click of Death»

Most of this information isn't directly related to this software, but since many 
SuperCat users also use Iomega's Zip and Jaz drives, it's included for your 
convenience only.

I've lost data on one of my Zip-disks. Is this caused by SuperCat? 
According to newsgroup postings and media reports, some users have experienced 
problems with their Zip and Jaz drives. However, we have no reason to believe that any 
such problems are related to the use of SuperCat. 

Unless you specifically instruct the program to delete selected files in the result file list, 
SuperCat does not access disks in such a manner that files can be deleted or otherwise 
changed or manipulated. There's simply no such programming involved. 

From a posting on alt.iomega.zip.jazz regarding Zip/Jaz drives on Windows NT: 
«Despite what Iomega says, you CANNOT reliably use the hardware eject button on a 
ZIP/JAZ drive under Windows NT. This is due to the way WinNT caches removable 
media. What happens is you insert your disk, and eventually the system starts caching 
its contents. Then you use the eject button and stick in another disk. Then, without your 
knowledge or permission, the system writes the contents of the cache from the previous 
disk to this second disk. Bingo! Instant disk corruption.»

There's also a well-known problem with such devices commonly known as «Click 
of Death»:

«Click Of Death, Click Death, and COD are names describing the first symptom of a set 
of serious data threatening problems being encountered with increasing frequency 
among users of Iomega's Zip and Jaz removable media mass storage systems. 

Without any warning a Click Of Death drive begins emitting a series of audible and 
distinctive clicking sounds, either when a cartridge is first inserted or when attempting 
to read or write data to or from a previously inserted cartridge.»

For more information, visit the Zip & Jaz Drive Click of Death resource page. 

From Iomega support:
«Like the predictable snap of a camera, a "click" from a Zip drive is normal when a Zip 
user inserts or ejects a Zip disk, or when a file on a Zip disk is saved or accessed. 
However, repetitive clicking is a symptom of a damaged drive or disk. If you believe 
your drive or disk has been damaged, please call Technical Support (1-888-4 
IOMEGA).» 

For more information, visit Iomega's website at www.iomega.com.

Disclaimer
No Nonsense Software cannot, and will not, answer or support any questions related to 
the use of any hardware storage devices. For such help, contact your local computer 
dealer or the hardware manufacturer. Most of the above information is gathered from 
various Internet sources, and should be treated accordingly. No Nonsense Software 
does not recommend or advise against the purchase or use of any computer hardware.



Getting started

If you've never used SuperCat before, these simple steps will help you create and 
search your own disk catalogs in a few moments.

Overview
SuperCat is a disk cataloging program, making it very simple to search for any file, even 
if it's located on a CD-ROM - or any other disk - that's not physically accessible from 
your system.

To achieve this, you must first create a catalog (sometimes referred to as an index or 
indexfile), that contains information about all the files on the cataloged disk. 

Later, instead of individually swapping and searching all your CD's, you can locate files 
on all cataloged disks, in one pass, with a single mouse click.

An operation that used to take forever can now be done in a few seconds.

Of course, you're not limited to cataloging CD's. Use SuperCat to catalog and search 
any disk media (including Zip- and Jaz-drives, SuperDisks, hard disks, diskettes, 
network drives, etc.).

For help on any SuperCat feature, you can always get context-sensitive help by clicking 
on Help or touching F1 on your keyboard. Now, we'll show you how to create and search 
your own catalogs:

Create catalog
Before you can search for files, you must create at least one catalog. This is what you'll 
need to do:

1. Click on the Create Catalog tab;
2. Select the disk you want to catalog (for example C:);
3.Click the Catalog button (for now, ignore the other settings);
4. When done, SuperCat will suggest a valid filename for your catalog. Accept the 
suggested name, or type your own, leaving off the extension. SuperCat will add the 
mandatory *.idx extension to the catalog name;
5. Click OK.

Done! You have now created your first catalog (also referred to as index file).

For help on other settings and catalog options, see help for Create Catalog.

Search
Having created at least one catalog, you can now search for files located on the 
cataloged disk.

1. Click on the Search tab;
2. Enter any search text in the Find field (e.g. "shell32.dll" or "readme.txt");
3. Click the Search button (or just hit Enter).



For help on other settings and search options, see help for search.



If the file you try to open is not located where it is expected to be, SuperCat will scan all 
available disks for an identical path and filename. This is useful if your network drives (or 
other disks) change drive letters, or if a catalog has been created on another computer, for 
example. This feature will only work for opening files (not for moving, copying or deleting 
files).



Search

See also: Beginners only    Search result window

Finding files is what SuperCat is all about. In the Search window, you can enter 
any text to search in file names, folder names, paths and/or SuperCat catalog 
comments and find your files in a snap.

Find field
Enter all or part of a file's name, path or SuperCat catalog comment in the Find field. 
You can re-use previous Find text by clicking on the field's down arrow and selecting 
text from a list of prior searches. In Options, you can set the number of previous search 
strings that SuperCat will retain. To clear the currently retained list, click on the button 
with a brown cross to the right of the Find field.

File names can contain both upper- and lowercase characters. All SuperCat searches are 
case insensitive: 'fileNaME', 'FileName' or 'fileNAme' are equal in all searches.

For several reasons, SuperCat ignores wildcards while seaching catalogs. If you want to 
find all file names with an extension of '.zip', don't add a preceding asterisk to the Find 
text. Simply search for '.zip'. If you want to find file names beginning with 'anyname', 
search for 'anyname' without a trailing asterisk. If you add beginning and trailing 
wildcards, they will have no effect. Wildcards added in the middle of search text likewise 
have no effect. If you search for 'win*.exe', 'wi?.exe', or 'win.?xe', SuperCat will treat 
them as searches for 'win.exe', 'wi.exe' and 'win.xe', respectively.

SuperCat incorporates two search features in place of wildcards. In the Search window, 
they're labeled Filename begins with and Refine, and they're discussed below. Refine 
search (shortcut key ALT+R) lets you quickly narrow down a list of files already 
displayed on the Result list.

You can search for any part of a long file name. For this type of search, be sure that 
Filename begins with (below the Find field) is not checked. If you're looking for a file 
named 'very cool disk cataloging program.zip', searching for 'ery', 'loging' or 'cool dis' 
will all find that file and perhaps a few others. To avoid finding too many files, use as 
long a search string as necessary to uniquely identify the file you're searching for. A Find 
text of 'cool disk cat' would likely find no other files than the one you're searching for, 
above.

If you search for 'zip' only (without the preceding extension period), you'll not only get 
hits on files with a '.zip' extension. You'll additionally find files containing 'zip' elsewhere 
in their file names, for example, 'winzip.exe'. SuperCat's default search behavior also 
looks for matching text in folder names, paths and SuperCat catalog comments. 
Therefore, a search for 'zip' will also add to the Result list all file names, whether they 
contain the character string 'zip' or not, located in a folder, path or SuperCat catalog 
comment that contains 'zip'. In other words, a search for 'zip' may add the file name 
'anything.txt' to the Result list if it's located in a folder named 'ZipFiles', or has a path of 
'C:\January\ZipFiles', or is found in a SuperCat catalog comment 'This is a virus-infected 
zip file.'

Search for



All words
An All Words query will return results containing at least one occurrence of every single 
keyword you enter. 

Remember: Search is not case sensitive under any circumstances, so you don't need to 
worry about capitalization.

Any words
An Any Words query is much less specific and will return results containing at least one 
occurrence of at least one of the keywords or phrases you enter. This is the least specific 
type of search. If you are having trouble getting results for your query, use an Any 
Words query.

Exact phrase
The Exact Phrase search method looks for the Exact Phrase you type into the Find box. 
You should not use    quotes, just enter in the phrase you want to find. Search will return 
results that contain at least one occurrence of the exact string of words you entered in 
the exact order you entered them. Search is not case sensitive under any 
circumstances.

After your initial results are returned, you could narrow your Search by adding keywords 
and click on the Refine button (see below).

Filename begins with Checkbox
Check this checkbox to only find file names that begin with the Find text. For example, 
searching for 'win' will find 'Win.exe', 'Win.ini' and 'Winning Blackjack Hands.doc', but 
not 'newindex.html'.

Catalog dropdown list
By default, SuperCat will search all catalogs listed in the Catalog dropdown list (and in 
the Catalog Explorer window). By clicking the down arrow on the Catalog dropdown list, 
you can limit search to only a single selected catalog. This would be useful, for example, 
if you need to list all '.html' files on your 'Web-projects' CD-ROM. 

Filter dropdown list
SuperCat makes it easy to search for specific file types. Use the Filter list to select which 
file type to find. You can also create and select your own file filters. (You can add or 
delete file extensions for various filters, and even add entirely new filters, by clicking on 
the tool bar Filters button and editing the Filters table dialog box.) Keep an eye on the 
status bar for useful information.

You always must enter Find text, even if you're using a filter. Using 'index' as Find text 
and selecting the filter Hypertext documents, SuperCat will find all your hypertext 
documents whose names contain 'index', such as 'index02.idx', 'newindex.html', and 
'what-a-nice-indexpage.shtml'.

Notice that using a filter can slow down your searches considerably when searching for 
all files ('*.*', which you may use for 'all files') of a general type. For example, if you 
select the filter Image files, SuperCat will have to process all files, looking for extensions 
of 'jpg', 'jpeg', 'gif,' etc.. Normally, it's much quicker to simply search for a text string of 
'.jpg', setting the filter to None (which is SuperCat's default filter setting). However, 



using a general filter may be handy on occasion.

Disk type dropdown list
Specify which Disk type to search. Choose between All, Removable, CD-ROM, Fixed, and 
Network. Choosing a Disk type other than All will disable the Catalog drop-down list 
(dimming it), and vice-versa.

Fields dropdown list
Select which Fields to search. The options are: All, Filename only, Path only, and 
Comments only. The default setting is All.

Ignore max hits for this search
If a search is interrupted by a screen message saying Search aborted, because the Max 
Hits setting has been exceeded, you can quickly select the Ignore max hits for this 
search checkbox, then click on the Search button again, and see search hits in excess of 
the Max Hits setting. The checkbox automatically deselects after completion of each 
search. Notice that listing thousands of files can be very time-consuming, especially on 
systems with limited resources. If you wish to abort a very long search that finds 
thousands of file names (caused, for instance, by searching for a single alphabet 
character), abort the search by touching your keyboard's Esc key. 

Sort file names
Check this checkbox to automatically sort file names alphabetically after each search is 
completed. This checkbox remains checked until you uncheck it. You can also sort files 
alphabetically by clicking on the Filename column or using keyboard shortcut F11.

List folders only
Check this option to search for specific folder names only. 

Search
Click the Search button to initiate finding files, folders, or SuperCat catalog comments 
matching your search preferences.

Refine
The Refine button acts like the Search button, except that it initiates further searches 
within the current Result list. Like the Search button, you must first enter new Find text 
before clicking on Refine. As an example, first search for files beginning with 'Win'. 
When the Result list is completed, immediately type in new Find text, e.g., a single 
character like 'Z', and click on Refine (or touch ALT+R) to find all file names within the 
current Result list containing a 'Z' (such as 'Winzip.exe' and 'Windzer.dll'). In this way, 
you can refine the search as many times as you need, for example, narrowing down the 
Result files to those beginning with 'Win', which also contain 'Z' and finally 'D' (such as 
'Windzer.dll').

Notice that a refined search will only search among file names in the Result list. Paths, 
folder names and SuperCat catalog comments are not searched during a refined search.

Append
The Append button acts like the Search button, except that it appends files matching 
new Find text to the bottom of your current Result list. Like a normal search, an 
appended search searches (by default) paths, folders, and SuperCat catalog comments 
containing the new Find text.



For example: To get a combined list of all files named 'readme.txt' and 'index.html', you 
first search for 'readme.txt'. Then, after changing the Find text to 'index.html', click the 
Append button. The result of the second search will be appended to the bottom of the 
Result list of the first search. You can append as many searches to the Result list as you 
want. The advantage of appended searches is that you can combine the results of 
several searches into one saved or printed report.

Result window
In SuperCat, all files found by a search, a refined search or an appended search are 
listed in the same Result window. Once the search is complete, you can sort the file 
names by clicking on the buttons at the top of each column: Filename, Path, Size, Date, 
Disk ID, and Comments. Clicking on each of the column buttons a second time will sort 
the list in reverse order.

You can select files in the Result window for file operations by highlighting them in 
standard Windows fashion. You can right-click on files to bring up a shortcut menu of 
file operations and external programs, including delete, copy, move, rename; launch 
Windows Explorer Find; copy file name, path or both to clipboard; create report; print 
or save Result list; edit a Comment; and other functions.



Search result window

See also: Search Find local files Browse Catalogs Find duplicates

Regardless of which SuperCat feature you're using (Search, Find local files, 
Browse catalog or Find duplicates), all files are listed in the Search result window 
located in the bottom of the main program window. If the Search result window is 
hidden, it becomes visible every time a filename in listed.

Maximize the search result window
Click on the Maximize search result window toolbar button to Maximize or restore the 
file list. You can also use keyboard shortcut F6. 

Sort your search results
Sort your results by clicking the column headings. 

Save and print your search results
Use the popup-menu, toolbar button or keyboard shortcut CTRL+P to open the Search 
result file list in the Report Editor.

What do the various colors of filenames shown in the search Result listview 
signify?

Files located inside zip-compressed archives and supported image file formats are listed 
in different colors than ordinary files. You can choose these different colors in the 
program Options dialog.

Also, when listing duplicates, each set of identical filenames are highlighted with 
alternate colors. You can select an alternate color of your own preference.

Drag and drop
You can drag and drop files listed in the search result window to other programs.

Search result pop-up menu overview

Right-click (or left-click if you have swapped your mouse buttons) to access pop-
up menus containing many useful options:

Open (run) any file
Double-click (or select Open from the pop-up menu) to Open any selected file. 

If the file you try to open is not located where it is expected to be, SuperCat will scan all 
available disks for an identical path and filename. This is useful if your network drives 
(or other disks) change drive letters, or if a catalog has been created on another 
computer, for example. This feature will only work for opening files. If it is not found, 
you will be prompted for the correct disk. 

Delete, Copy, Move and Rename
In the search result window, you can easily perform simple file operations, without the 
need for Explorer or other programs. The catalog and search result window are updated 
accordingly (if the Update catalogs after file operations (delete, move) option is 
checked). 



Copy: Select any file and click Copy in the popup menu. Choose a destination folder 
(you can also create a new folder by clicking the Create folder button), and confirm 
(OK). Copy will not do any changes to any catalog or the file list.

Move: Same procedure as for Copy. Moving files will update file list and catalog if 
source and destination are located on the same drive. In other words, moving a file 
from c:\temp to c:\programs will update the file list and catalog; moving from c:\temp 
to d:\temp will delete the entry from the catalog (as these are located on different 
drives). 

Rename: Use popup menu or keyboard shortcut F2 (default Windows shortcut) to 
rename the currently selected file. If a new name is entered and confirmed, the catalog 
and file list are updated accordingly.

Delete: Use popup menu or keyboard Delete button to delete selected file(s) to the 
Windows recycle bin (if applicable). The catalog and file list are updated accordingly.

NOTE: Catalogs will only be automatically updated if the Update catalogs after file 
operations (delete, move) option is selected. For optimal speed, this option is unchecked 
by default. If you delete or move a lot of files, it's often faster to update an entire drive 
when you're all done, or periodically, than to have SuperCat automatically update the 
catalog after every file deletion and move.

Properties
Select Properties in the popup-menu (or use keyboard shortcut CTRL+ENTER) to view 
file properties. You will be prompted to insert the correct disk if not available.

Copy selected ...
Path as text: Copy selected path as a text string to the Windows 
clipboard.
Filename as text: Copy selected filename as a text string to the Windows 
clipboard.
Path and filename as text: Copy selected path and filename as a text string to the 
Windows clipboard.

Result output
Create report: Create an editable report, ready for editing, printing or 
saving as a text file.
Copy results: Copy file list to Windows clipboard.
Save results: Save the file list as a text file (*.txt) or a Rich text file 
(*.rtf). 

Add to duplicate exclusions
Easily add File names, paths and extensions to the Find duplicates exclusion list.

Open Folder...
Opens the currently selected folder in a single-pane Windows Explorer window.

Explore Folder...
Opens the currently selected folder in a Windows Explorer window.

Find Files or Folders...



Open the Windows Find files and folders dialog.

Hide non-accessible files
Use this option to hide (remove) all files that are currently not accessible. The 
(unavailable) files are removed from the current search result file list only. They will not 
be deleted from the catalog itself.

Calculate checksums
Calculate checksums for the currently selected files. The checksums will be added to 
their respective catalogs as file comments.

Edit comments
(Shortcut F12). Add or edit comments (descriptions) for the currently selected files. 
Comments are an efficient way to remember and easily find important files. You can 
only enter comments for cataloged files (i.e. you cannot add comments after running a 
Find local files search). You should remember, however, that you will lose your catalog 
comment for a file if you move the file by a program external to SuperCat, such as by 
using Microsoft's Windows Explorer.



File checkboxes (for selecting multiple files)

If you have selected the Enable file checkboxes option in the Options dialog, you 
can easily select multiple files in the search result list. 

Selecting files by ordinary Windows methods, particularly Ctrl+Click, can become 
tedious. That's because if you accidentally single-click on a line during the selection 
process, or your hand slips off the control key while clicking, all of your previous 
selections will lose their highlighting. It's bothersome to have to remember to keep the 
Control key pressed, and physically tiring to hold that key down, while selecting 
hundreds of files.

For handling long lists of files in the Result list, SuperCat has introduced "file-tagging." 
When you check the Enable file checkboxes option, a small checkbox appears to the left 
of every file name in the "Result - Search Catalogs" and "Result - Find Duplicates" 
windows. With these checkboxes, you can select multiple files without worrying about 
holding down the control key. You can change your mind all you want and easily move 
up and down a long list without worrying about that control key.

If for any reason you don't want to use file checkboxes and wish to continue selecting 
files by ordinary Windows techniques, leave the Enable file checkboxes option 
unchecked.

IMPORTANT NOTE: When Enable file checkboxes is checked, you cannot perform file 
operations, such as delete, move and copy, on any file--even a single highlighted file--
that is not tagged. The first time you forget this when Enable file checkboxes is 
checked, and you try to delete, move or copy a filename that has no check in the 
checkbox, you'll likely be confused that nothing happens. The answer is that you must 
first put a check in the checkbox of the file you wish to delete, move or copy--even just 
a single file.

You'll learn to appreciate this behavior when Enable file checkboxes is enabled, because 
it's an important safety feature: Nothing's going to happen to files that don't have 
checks in the checkboxes. If five files are tagged with checks in their checkboxes, and 
ten other files are simultaneously highlighted but don't have checks in their checkboxes, 
then a delete, move, or copy will only happen to the five tagged files--nothing will 
happen to the ten files that were merely highlighted but had no checks in the 
checkboxes.

When Enable file checkboxes is enabled, you can select, or "tag," files for file operations in 
the following ways:

1) Individually click on each filename checkbox. A second click will remove the check 
from the checkbox. Individually clicking each checkbox isn't recommended for long lists.

2) Move the cursor to a single desired line on the Result list, or highlight the line by 
clicking anywhere on it, and touch the spacebar. A second touch of the spacebar will 
remove the check from that single checkbox. Note that if you touch the spacebar while 
multiple lines are highlighted, only one file, the last file that was highlighted, will be 
checked or unchecked.

3) Use ordinary windows methods to highlight multiple lines on the result list (e.g. 



Ctrl+click and Shift+click), and then click on the third button above the Result window 
(the Tag filenames currently highlighted button). You can remove checks from multiple 
lines by first highlighting them and touching the fourth button above the Result window 
(the Untag filenames currently highlighted button).

Note that when Enable file checkboxes is enabled, ordinary windows highlighting 
methods only control which files may be tagged--highlighting won't directly control 
which files will be deleted, moved, or copied. Only those file names with checks in the 
checkboxes can have file operations performed on them.

However, if you disable Enable file checkboxes, then highlighting will directly control 
which files are deleted, copied, or moved.

4) Click on the first button above the Result list (the Tag entire list button) to tag all 
files on the Result list.

5) Click on the second button above the Result list (the Untag entire list button) to 
untag all files on the Result list.

Although individually clicking on each checkbox is adequate for short lists of files, 
tagging files by touching the spacebar is the recommended method, especially for long 
lists. The time lag after clicking on a single file, while Windows processes the click 
before putting a check in the checkbox, can take several seconds on very long lists (a 
thousand files or more). Tagging a file with the spacebar, however, results in virtually 
instant placement of a check in the checkbox no matter how long the list.

For processing very long lists of files, such as tagging hundreds or even thousands of 
files during a Find Duplicates procedure, an ideal method of tagging files is to use your 
right hand on the up/down arrow keys and use your left hand on the spacebar. This is a 
very relaxed and enjoyable way to tag and untag files, far less tedious than individually 
clicking each checkbox with a mouse click.



Keyboard shortcuts

Learn to use keyboard shortcuts that appear to the right of commands in 
SuperCat's menus. Here's a list of SuperCat keyboard shortcuts you may find 
useful.

All program tabs
F1 Display Help.
F8                Display Options dialog.
F9              Display Filters dialog.
Esc            Temporarily Close Image preview (ImageCat) when visible.
ALT+F4 Exit SuperCat program.
ALT + Backspace Disable/Enable image-preview feature (ImageCat).

Search tab (and the Result lists of the Search, Create Catalog, and Catalog 
Explorer tabs)

F12               Bring up the Edit Comment dialog.
F11 Reverse the order of the Result list.
ALT + S Commence Search. Search must be the active program tab, and search 

text must be in Find field.
ALT + R Commence Refined search. To work correctly, prior Search must have 

been completed with data in the Result list, and Find field must be 
edited to contain different text from original Find text.

ALT + A Commence Append-search. Adds second search result to prior Result 
list.

ALT + W Prepare for new search. Clears search Result list and highlights text in 
Find field.

CTRL + O Open (run) selected file. For example, touching CTRL+O on an image file 
will launch that image in your system's default image-viewing program.

DEL Delete selected file(s).
CTRL + C Copy selected file(s).
CTRL + X Move selected file(s).
F2          Rename selected file. Works only on single file or first file of selected 

block of files.
ALT + ENTER Display file properties. Works only on single file or first file of selected 

block of files.
Shift + F1 Copy selected file's path as text to clipboard.
Shift + F2 Copy selected file's name as text to clipboard.
Shift + F3 Copy selected file's combined path and name as text to clipboard.
CTRL + F Open folder of selected file in Windows Explorer. Works only on single 

file or first file of selected block of files.
F3              On Search Result list, only, launch Windows Explorer's Find Files or 

Folders dialog box to help you find a local-drive file. 
CTRL + P With any Result list showing, launch SuperCat's Report Editor to save 

and/or print the Result list. 
CTRL + Alt + P Copy any Result list to clipboard.

Create Catalog tab
ALT + P Abort disk cataloging or updating.



Catalog Explorer tab
CTRL + F5 Update selected catalog(s). 
F2              Rename selected catalog. You can rename only one catalog at a time.
DEL        Delete selected catalog(s). You can delete more than one catalog at a 

time.
F5              Refresh Catalog explorer view.
CTRL + A Select all catalogs.

Find Local Files tab
ALT + F Commence Finding files.
ALT + W Prepare for new search.

Find Duplicates tab
ALT + F Find duplicates.
ALT + S Abort Find Duplicates (when active).
ALT + W Prepare for New search.

In addition to these keyboard shortcuts, you'll find additional useful features in SuperCat's 
right-click pop-up menus.



Create catalog

See also: Getting started

Cataloging your disks with SuperCat is very fast and easy. Simply select the drive 
(or folder) you want to catalog, set your preferences and click the Catalog button. 
Using SuperCat, you can even catalog unmapped network disks.

SuperCat will catalog all folders, including hidden and system directories.

You can also create a new catalog by selecting SuperCat Catalog from Windows Explorer's 
pop-up menu. 

Include subfolders
By default, SuperCat will catalog the selected drive (or folder) and all its subfolders. 
Uncheck this option if you only need to catalog files at the root level of the specified 
location.

Catalog zipfile content
Catalog the content of your zip files. Files found inside zip-compressed archives will be 
displayed in a different color than ordinary files.

Calculate checksum
This will calculate a CRC32 value ("checksum") for all file types specified under Options 
> Autocomments and checksums (keyboard shortcut F8). The checksum(s) will be 
recorded in the catalog in the same manner as autocomments.

CRC stands for "cyclic redundancy check". It's a calculation made from all the data in a 
file. CRC values can be used for many things, for example to verify if two files are 
identical or checking file integrity. For example, many image and MP3 collectors use 
checksums to search for identical files, etc. 

The CRC-32 value calculated by SuperCat matches the one from programs like PKZIP 
and WinZip.

Enable autocomments
A very useful feature in SuperCat is autocomments. Select which file types you want 
autocomments for in the Options dialog.

Autocomments and checksum settings
Click this button to open the Autocomments and checksum settings tab in the program's 
Options dialog.

Exclusions
Using exclusions, you can ignore all files in and below a particular folder, all files that 
have a specific name, or all files with a particular extension: 

Extensions: Enter any file extension into the edit field and click the Add button. 
Wildcards are ignored (just enter the extension itself, for example txt or gif)

Filenames: Enter any filename to ignore, and click the Add button.



Folders: Click the Add folder button and browse for the folder to ignore. 

Eject CD
Eject CD's automatically after cataloging. CD's will not be ejected if you catalog any 
other disk media.

Show info
Show various information before saving the new catalog. Keep this option checked if 
you wish to enter your own catalog filename before saving the catalog. For most users, 
we recommend that this option is checked at all times. See Save catalog for more 
information on filenames, etc.

Catalog only what you need
Unlike most disk cataloging programs, SuperCat allows you to catalog any part of a 
disk. If you just want to catalog a single folder, fine. Just navigate to the correct folder, 
make sure Include subfolders is unchecked, and click the Catalog button.



Right-click cataloging

If the Option Right-click catalog is checked, you can create a catalog by right-clicking any 
drive or folder in Windows explorer and choose SuperCat Catalog in the pop-up menu.

SuperCat will then be displayed, showing the selected folder in the Create catalog tab. Set 
your preferences and start cataloging by clicking the Catalog button.



Save catalog

After you have created a catalog, you must enter a valid filename. If you wish, you 
can also enter your own descriptive comments.

Catalog filenames can contain up to 255 characters, including spaces. They cannot contain 
the following characters: \ / : * ? " < > | 

If you don't enter a filename, your catalogs are named automatically using one of the 
following methods: 

Entire disks with a volume label
If you have cataloged an entire disk, starting with its root folder (e.g. C:\ ), the disk 
Label will be used as filename (if found). If a disk is labeled WINDOWS95, this will be 
the name of the catalog. 

If you catalog the same disk several times (or another disk with the same volume label), 
the name of the index will be WINDOWS95 #1, WINDOWS95 #2, and so on.

Entire disks without a valid volume label
If the disk does not have a label name, the drive letter will be used instead. For 
example A-DISK.

Subfolders
If the start folder for your catalog is a subfolder (like C:\windows), this path will be 
used as catalog filename. Since filenames cannot contain colons or backslashes, these 
will be replaced by an _(underscore) character.

In this example, the catalog would be named C_WINDOWS.

Unmapped network disks
The disk's UNC path will be used as the basis for a catalog filename. 

Tip
Using catalog filenames suggested by SuperCat is simple and straightforward if you only 
catalog a few disks, containing straightforward and understandable volume labels.

However, in many cases you will probably wish to use your own, easy-to-understand 
filenames, such as "Zip-disk # 21" or "PC computing cover disk feb-2001". To enter 
your own catalog filenames, make sure the Show info checkbox in the Create Catalog 
tab is checked.



Catalog explorer

Use the Catalog explorer tab to manage your existing catalogs. Open the pop-up 
menu to access useful options like Update catalog and Properties.

Maximize the Catalog explorer window
You can use keyboard shortcut F7 to maximize or restore the size of the Catalog 
explorer file list. You can also configure this in the main Options dialog.

Update catalog(s)
Update your catalogs, both to automatically remove non-existing files and to add new 
files to the catalog. Update catalog(s) will use the same preferences which were 
specified when the catalog was first created. All user added comments will be saved in 
the updated catalog.

Browse
By selecting this option from the pop-up menu (or double-clicking on a catalog), you 
can browse folders and files located in the selected catalog.

Notice: If the Maximize catalog list option is selected (in the Options dialog), the browse 
catalog treeview and file list will not be visible before you switch from the Catalog 
Explorer to another tab. Also, the browse features are primarily intended for browsing 
offline disks (i.e. removable disks). For online disk media (like harddisks) it's usually 
more practical to browse using Windows Explorer. 

Properties
Here, you'll find useful information about the cataloged disk and the catalog itself. 
Change disk volume label and edit or add your own comments about the catalog. You 
can also change the drive letter for your catalogs. This is useful if your drive letters have 
changed after installing a new drive, etc.

Rename
Catalog filenames can contain up to 255 characters, including spaces. They cannot 
contain the following characters: \ / : * ? " < > | 

We recommend that you use logical, easy-to-understand names for your catalogs, 
something like "Zip-disk # 21" or "PC computing cover disk dec-99". It's suggested that 
you use the same name for your catalog as your disk label (or vice versa). 

Delete
You will be prompted to confirm your action before any catalog is deleted. Should you 
delete a catalog by mistake, you can undelete it from the Windows Recycle bin (located 
on your Windows desktop). 

Add to schedule
Add the highlighted catalog to the list of scheduled automatic updates. See Scheduler 
for more information.

Remove orphans
Remove all non-existing files from the catalog. This option will not verify files located 
inside zip-compressed archives. It will only check if the zipfile, itself, exists. 



Refresh view
Refresh the catalog file list. Use this if you have undeleted a catalog from the Windows 
Recycle bin.

Select All
Select all catalogs. Use this option if you're going to delete all your catalogs in a single 
operation.

Create list
Generate a HTML-formatted list of all your cataloged disks, including all information 
displayed in the Catalog Explorer listing. The report file is saved in the current indexfile 
folder, under the filename catlist.html (creating a new list will overwrite any old file with 
this name). If you want to print this list, it is often preferable to select a landscape 
paper orientation for your printer. This option requires that you have a web browser 
installed on your system for proper display of the list, although the HTML file will be 
created anyway. 



Catalog properties

Select Properties in the Catalog Explorer pop-up menu to open the catalog's 
property window.

Here, you'll find useful information about the selected catalog and the cataloged disk, like 
total and free disk space, catalog root folder, etc. 

Drive letter and disk label
You can change the root drive letter for the selected catalog. This is useful if your drive 
letters have changed after installing new hardware, using different CD-ROM drives, 
working with catalogs created on another PC, etc. You can also change the disk volume 
label, provided that your system allows you to do so. You cannot change the volume 
label for CD-ROM's or any other read-only media.

Catalog description field
The Catalog description field is not searchable. Catalog descriptions are visible in the 
Catalog Explorer catalog list and are only included for description and recognition of the 
general content of your catalogs.



Find local files

In the Find local files tab, you can search for files without creating a catalog first. 

Both in appearance and functionality, Find Local Files is similar to Windows' own "Find files 
and folders". You can search for multiple file types using commas or semicolons between 
search targets, e.g. "*.zip,*.gif,*.doc".

Find Local Files allows you to print, copy and save your search results. In addition, you can 
also see Autocomments for supported file types. 

There is no "Max hits" limit when searching for local files.

Obviously, you cannot use the Find Local Files tab to search for offline files. To search 
cataloged disks that are not currently available on your system, click the ordinary Search 
tab, instead.

Size and Date
By clicking the Size and Date tab, you can specify additional search criteria, such as text 
to search for, file dates, file attributes and size.



Find duplicates

See also: Exclusion lists

In the Find duplicates tab, you can find duplicate files located on your cataloged 
disks.

Due to the nature of this operation, finding duplicates can be time consuming. First, 
SuperCat will format all your catalogs to a suitable data format. Then, it will start 
comparing filenames. If you're using the default option (Name, size and date), every 
time SuperCat finds matching filenames, it will also compare the size and date of those 
files. Comparing thousands of files, this may take a few minutes. However, if you are 
looking only for duplicate image files, then you should select "Name and Size," which 
will result in considerably faster preparation of the duplicates Result list.

Notice that the progress is displayed in the status bar, and that you can abort the 
operation at any time.

Find duplicates by
Select one of these three radio buttons to set your search criteria. Select to find 
duplicate Filenames only, Files with the same name and size, or files with identical 
name, size and date. If not searching for image-file duplicates, where you'll be unlikely 
to be concerned about date and time, we recommend that you use the name, size and 
date    option.

Minimum file size ___ KB
For improved speed, we recommended that you set a minimum file size for the 
duplicates you want to find. If, however, you believe you've found too few duplicates, 
either set the minimum file size to much smaller or uncheck the Minimum Filesize 
option.

By default, SuperCat will only find and list files that are at least 10 KB. You can set this 
to any size you want (from 1 KB up to 50,000 KB). If you want to list all duplicates, 
regardless of size, uncheck the Minimum file size option.

Enable exclusions
If you wish to enable exclusions for your search, you can do so by selecting the Enable 
Exclusions checkbox. This will exclude all filenames, file types, paths and catalogs set in 
the Exclusions dialog, accessible by clicking on the Exclusions list button.

Search all catalogs
When the Search all catalogs option is checked, SuperCat will search for duplicates in all 
catalogs. You can also search for duplicates in selected catalogs only, by first 
unchecking this option and then tagging the catalogs you want to search.

"Old catalog" error
SuperCat originally rounded off all file sizes to kilobytes (KB), as Windows Explorer 
does. In response to user requests for exact byte size for aiding comparison of files, 
SuperCat (version 4.0 and later) now offers exact byte size in its catalogs.

Unfortunately, because of this important change in the catalog file format, you can no 
longer find duplicates in old catalogs (created with versions prior to SuperCat 4.0). 



You'll need to create new catalogs using SuperCat 4.0 or later.

Find duplicates alternate color
When listing duplicate files, sets of identical filenames are displayed using alternating 
background colors. In the Options dialog, you can select an alternate color of your own 
preference.

Tips
If you have many duplicates on the Result list, activate Enable file checkboxes in 
Options>General. Doing so will allow you to casually select duplicates you'd like to 
delete without continually having to hold down the keyboard's Control key. 

It's recommended that you use your right hand on the arrow keys to move up and down 
the list and your left hand to tap the spacebar to tag and untag filenames. Enable file 
checkboxes allows you to easily review your selections and change your mind about 
which duplicates to delete, without having to worry about keeping the Control key 
pressed.

Remember that you cannot delete files from your CD-roms, or other read-only media! 
So when you're all finished, click on the Path column (or Disk ID column) of the Result 
list, which reorders the files listed by path name and allow you to easily make sure that 
no CD-rom files have been tagged for deletion.

Reviewing a very long list of duplicates can be tiring, even when using a fast system like 
SuperCat. First, you can limit the total number of duplicates found by running the 
routine on only one or just few drives. When done, select other drives. Then, go back 
and select all catalogs for the Find Duplicates routine.

Also, you should feel free to quit anytime, delete the duplicates found thus far, quit, and 
later update your catalogs so that you can restart Find Duplicates when you're ready to 
continue.

IMPORTANT
For the Find duplicates operation to work properly, you need some free disk space 
(equivalent to twice the size of the catalog files themselves). This space is used for 
temporary files that are created (and removed) by the Find duplicates routine. The free 
disk space must be on the same drive as your catalog folder is located. 



Exclusion lists (find duplicates)

See also: Find duplicates

Using exclusions, you can ignore all files in and below a particular folder, all files 
that have a specific name, or all files with a particular extension. You can also 
exclude specific catalogs.

If you wish to search for duplicates without exclusions, simply uncheck the Enable 
exclusions option in the Find duplicates tab.

Catalogs
Specify catalog filenames to exclude. You can select catalog filenames from a list, or 
enter any valid filename manually.

Extensions
Enter any file extension into the edit field and click the Add button. Wildcards are 
ignored (just enter the extension itself, for example txt or gif)

Filenames
Enter any filename to ignore, and click the Add button.

Folders
Click the Add folder button and browse for the folder to ignore. 

Exclude subfolders
If you want to exclude all subfolders of any folder you've listed in the Folders section of 
Exclusion Lists    (for example, to automatically exclude all subfolders of C:\Windows), 
make sure that the Exclude all subfolders option is checked. Enabling this option will 
save you the task of individually listing every subfolder and sub-subfolder contained in 
large folders such as C:\Windows.

On the other hand, occasionally you may want to find duplicates only at the root level. 
In that case, be sure to uncheck the Exclude all subfolders option.



Scheduler

In the Scheduler tab, you can schedule your catalogs for automatic, unattended 
updates (reindexing). 

This tool is primarily intended for network administrators and advanced users 
maintaining many disk partitions, hard disks and network drives. 

However, being simple to operate, any computer user may find it's useful for performing 
regular updates of their main hard disk catalogs, for example. Many users rely on this 
method to locate files on their local hard disks, because it's a lot faster to search a 
SuperCat catalog than to actually search a hard disk using Find Local Files or Windows' 
Find utility.

To add a catalog to your scheduled updates, follow these simple steps:

· Click on the Add button to schedule a catalog for automatic updates
· Select any catalog in the catalog file list
· Select to schedule a Daily, Weekly or Mothly update
· Set the time for the update to start
· If you have choosen Weekly or Monthly updates, select a weekday or day of the 
month, respectively

The next catalog to be updated is displayed with bold text in the Scheduler file list.

All catalogs are updated using the same preferences that were specified when the 
catalog was created.

The scheduled updates are run without displaying errors or warnings. 

IMPORTANT
Be careful about adding removable disks to the scheduler, since many different disks 
share the same drive letter. For this reason, you will see a warning when adding 
removable disks to the scheduler. If the disk currently inserted in the drive is different 
from the one that was originally cataloged, your original catalog will be overwritten and 
lost! This can be a significant loss if you've there were Comments for file names in the 
overwritten catalog. (Comments are always contained in catalogs, not attached to the 
filenames, themselves.)

To edit an existing Scheduler entry, select the entry in the Scheduler list, and click on 
the Edit button, or double-click.

LOG
All updates are logged. If you only wish to log errors, make sure that the Log errors 
only option is checked. The View log and Update now buttons need no further 
explanation.

NOTE FOR USERS OF PREVIOUS VERSIONS: "UPDATE NOW"
In previous versions, you could use the scheduler to immediately update many catalogs 
in a single operation (using the Update now button). In SuperCat 4.2, this option has 
been moved to the Catalog explorer tab. Simply select multiple catalogs in the Catalog 
explorer file list, and select Update catalog(s) in the pop-up menu (shortcut CTRL+F5).



Browse catalogs

Select Browse catalog from the Catalog Explorer pop-up menu or double-click on 
any catalog to browse your cataloged disks.

This will open a browse treeview where you can navigate your catalogs. 

Folders that contain no files are neither included in SuperCat catalogs nor displayed in 
the Catalog Explorer treeview. If no files exist in a folder, then an associated folder 
name cannot be captured by SuperCat. The reason for this is that during cataloging, 
SuperCat catalogs files, not folders. 

In the treeview, files are only shown for the currently highlighted folder. Files in a 
subfolder of a highlighted folder are not shown until you highlight the subfolder in the 
treeview.

Pop-up menu
Like most SuperCat windows, the browse view also has its own pop-up menu. Right-
click (or left-click if you have swapped your mouse buttons), to access the following 
options:

Expand all: Expand entire treeview

Collapse all: Collapse entire treeview

Open folder: Open the folder in a single-pane Windows Explorer window

Explore folder: Open the folder in a two-pane Windows Explorer window

Notice
You can only browse catalogs created with SuperCat 2.1 or later. 

If the Maximize Catalog List option is selected (in the Options dialog), the browse 
catalog treeview and file list will not be visible before you switch from the Catalog 
Explorer tab to another tab. Also, the browse features are primarily intended for 
browsing offline disks (i.e. removable disks). For online disk media (like harddisks), it's 
usually more practical and faster to browse using Windows Explorer. 



Internal Unzipper

SuperCat has its own unzip utility, making it very simple to view the content of, or 
extract, your zip-compressed archives. 

Start the unzip utility by double-clicking on any *.zip file (requires that the Use internal 
unzipper option is checked), by selecting Unzip utility from the SuperCat File menu, or by 
clicking the Unzip utility button on the main toolbar.

To open another zip file while the unzip utility is running, just select File > Open archive.

You can also double-click on text files (listed in the file-list window) for a text preview. In 
other words, you can read text documents inside zip-compressed archives without first 
having to extract the file(s).

The unzipper extracts files from the archive to the folder specified in the Extract to field. You 
can specify this folder in two ways:

· Select a drive and folder in the navigation treeview
· Type a folder name in the Extract to field

There are a few basic options you must choose from before extracting your files:

· Select All files to extract all files from the current archive
· Click Selected files to extract selected (highlighted) files only

· The Use folder names option determines if you will use folder names (also known as 
path names) stored in the archive. If this option is checked, any folder names stored 
in the archive will be appended to the Extract to folder when appropriate. If this 
option is not checked all files will be extracted to the same folder, regardless of any 
folder names in the archive.

· The Replace existing files dropdown menu determines what to do with existing files 
(Prompt, Always replace, Never replace)

Delete files from zip-archives
In the Unzipper pop-up menu, you can delete selected files located inside the zip-
archive. You will be prompted before files are deleted.

Notice
The internal unzipper is not intended to replace your ordinary unzip utility. For example, 
you cannot create new archives or add files using this tool. It is provided for your 
convenience only.



Reports

See also: Options: Reports

With SuperCat, you can easily create your own printable file lists. You can also 
save your results as hypertext documents (*.html) or database-ready text files 
(*.sdv).

In the search result window, use the pop-up menu or keyboard shortcut CTRL+P to 
open the current file list in SuperCat's own report editor. You can also click the print 
button on the toolbar (if visible).

To save your results as hypertext or database-ready text files, simply click the Save 
results to file button (or keyboard shortcut CTRL+S), and choose the desirable file 
format. The *.sdv database files are supported by programs like Microsoft Access and 
Excel. You cannot save reports in these two formats from SuperCat's report editor. 
Instead you have to first select the proper output format in the Reports tab of Options, 
and then Save the report to disk (instead of sending it to the SuperCat report editor).

The list in the report editor is sorted in the same manner as the search result list itself. 
This means that you can print your lists with files displayed in any order (by name, 
path, size, date, etc.) 

The report editor works like an ordinary text editor. You can save your report as a text 
file, copy the entire contents to the clipboard for use in other applications, or print it. 

If you need to do advanced text formatting or other operations (like search and 
replace), you should save the report as a text file and open it in a word processing 
program (use a fixed-width font like Courier New for proper column alignment).

The report editor has these menu buttons:

Save Save the report as an ordinary text file (*.txt) or a Rich text file 
(*.rtf).
Copy all Copy the entire report to the clipboard.
Find Search for any text (in the report).
Print You guessed it - print the report.

Bold Format selected text as bold.
Italic Format selected text as italic.
Underline Format selected text as underlined.

If you need to copy, cut or paste only parts of the text, you can use the standard 
Windows keyboard shortcuts:
CTRL+C Copy selected text
CTRL+X Cut selected text
CTRL+V Paste text from clipboard.

PrintFolder Pro
If you need to print entire SuperCat catalogs, or want to create formatted file lists with 
speed and ease, you should take a look at PrintFolder Pro, an inexpensive shareware 



program available from our website.

When using report editor, I cannot save the search result as hypertext or 
database-files.

No, the report editor can only save results as plain text (*.txt). If you need to save your 
search results as hypertext documents or as semicolon-separated text files (*.sdv), you 
should click the Save results as file button or use keyboard shortcut CTRL+S instead.

What are "Semicolon separated database files" good for?
Saving search results as *.sdv-files makes it very easy to import data into database 
software like Microsoft Access, FoxPro, etc. This can be very useful for advanced users, 
network administrators, etc. 

Notice
The report editor uses the Courier New fixed-width truetype font. This is a standard 
Windows font. If you don't have this font installed on your system, we recommend that 
you install it. Refer to your Windows documentation for help on how to install fonts.



Options

Open the Options dialog by selecting the menu's File > Options, using keyboard 
shortcut F8, or clicking on the Options toolbar button (crossed hammer and 
wrench icon). 

The Options dialog contains 4 windows, each accessible by clicking on its own tab: 

General
Display
Reports
Autocomments and Checksums



Options: General

Set general program options.

Add SuperCat to Explorer pop-up menu
Add a SuperCat entry to the pop-up menu in Windows explorer. Enable this option to 
easily create SuperCat catalogs from within Explorer.

Write supercat.id
To identify drives or folders as 'previously cataloged,' SuperCat writes a small file named 
supercat.id on the root of a cataloged disk or folder (when possible). It helps SuperCat 
notify you that you might be creating a second catalog of the same drive or folder, 
which later may lead you to believe you have duplicate files after searching the catalogs. 
Supercat.id is a text file containing only the words "This disk has been cataloged by 
SuperCat. You can safely delete this file." When you see a supercat.id file on any drive 
root or in any folder, you know that the drive or folder has already been cataloged by 
SuperCat. If for any reason you do not wish to write such identification files (for 
example when cataloging network drives used by others or for creating a special-
purpose temporary CRC catalog), uncheck this option.

Tray minimize
This option affects what happens to SuperCat when it's minimized. If left unchecked, 
SuperCat will minimize to the Start bar. If checked, this option will cause SuperCat to 
minimize as a small icon in the system tray (depending on where you have your 
Windows Start bar located, generally next to the clock on the right-hand side of the 
Start bar). The advantage of minimizing to the tray is the small "footprint" of a 
SuperCat icon compared to a larger Start-bar tab with "SuperCat" written on it, which 
may be a factor if you have a large number of programs open simultaneously.

Save window position 
Save the SuperCat program window position and size.

Use internal unzipper
Instructs SuperCat to use its internal unzip utility, called UnzipCat, whenever you 
double-click on a *.zip file in a SuperCat Search Result or Browse window. You'll find 
UnzipCat to be a capable and fast unzip program. However, if you prefer to open *.zip 
files with your Windows default Unzip program (like WinZip), uncheck this option.

Confirm prev. cataloged
Before commencing creation of a new catalog, checking the Confirm prev. cataloged 
option causes display of a Previously cataloged dialog (Yes/No) if a disk or folder has 
been cataloged previously, asking you if you'd like to create a new catalog anyway. This 
is an important warning dialog, and the option should always be checked unless you 
have a good reason not to want it. If you have two catalogs of the same drive or folder, 
and the catalogs are stored in the same folder, then a Search Result will display more 
than one listing of a file, falsely indicating that duplicate files exist.

Note that the Previously catalog warning will only be activated if a SuperCat.id file is 
found in the root of the drive or folder about to be cataloged. Thus, you can still wind up 
with files in a folder being listed in more than one catalog, falsely indicating duplicates 
during a search. Keep this in mind when you catalog individual folders rather than entire 
disks.



Confirm update save
It's possible to accidentally initiate an update of a catalog. To allow a user to cancel an 
accidental update, or merely to change his mind, the Confirm update save option 
displays a Confirm dialog (Yes/No) before saving an updated catalog. If this option isn't 
checked, a catalog will automatically be saved after each update.

Confirm file delete
For maximum security against accidental deletions, checking the Confirm file delete 
option will display a Confirm File Delete dialog (Yes/No), before deleting files from a 
Search Result and sending them to the Windows Recycle Bin. If this option isn't 
checked, deletion of a file will immediately send the file to the Recycle Bin. Note that in 
SuperCat, you cannot bypass the Recycle Bin when deleting files. Thus, unchecking the 
Confirm file delete option still leaves you with strong protection against accidental file 
deletion.

Update catalogs after file operations (delete, move)
In the search result window, you can perform basic file operations. If Update catalogs 
after files operations (delete, move) is checked, then catalogs will be automatically 
updated after each individual file deletion or move. For optimal speed, this option is 
unchecked by default. If you delete or move a lot of files, it's much faster to update an 
entire drive when you're all done, or periodically, than to have SuperCat automatically 
update the catalog after every file deletion and move.

Display max. hits message
If the Ignore max hits for this search checkbox on the Search window isn't checked, and 
the Display max. hits message option is checked, SuperCat will display a Search aborted 
message dialog informing you that your search has returned the maximum number of 
hits. If the Display max. hits message option is unchecked, then a search will still be 
aborted when the maximum number of hits is returned, but you won't be informed why 
the search has stopped. Unless you have a good reason for not wanting to be warned 
you've exceeded the maximum number of hits, you should always leave the option 
checked.

Abort search after finding ___ files
This option allows you to set the maximum number of files that you'd like to be found 
during any search from 10 to 9,999. If the Ignore max. hits for this search option on 
the Search tab is left unchecked, then a search will stop when the number of found files 
reaches this limit. Because listing a large number of files can, itself, be slow, and 
because visually scanning a very large number of found files can be even slower, you 
can set the maximum number of hits you'd generally feel comfortable with before 
automatically stopping a search. If, on occasion, you need to list more files than the 
maximum you've set, simply uncheck the Ignore max hits for this search option and 
then re-initiate that particular search.

Recent list ____
You can limit how many search strings (between 0 and 30) SuperCat will retain between 
program sessions in the Find dropdown list. The default value is 10. When starting the 
program, your last used search string will always be displayed as default Find text. 
These strings are saved in the Windows registry. For practical and security purposes, 
setting the number to zero will delete all existing search strings from the registry, and 
no previous searches will be visible when running future SuperCat sessions. You can 
also use the Clear search history button (having a reddish-brown cross icon) located to 



the right of the Find field in the Search tab, which will delete all search strings from the 
dropdown list, but not text currently shown in the Find field.



Options: Display

Set various program display options, like font size and colors.

Show info tips
At times, a file name and/or path may be so long that they aren't shown completely in 
the Search Result or Browse windows. With Show info tips checked, holding the cursor 
over a file name or path (without needing to actually click on and highlight it) will 
launch a file-info tip for a few seconds, displaying the entire path and filename of the 
file. 

Maximize Catalog explorer 
Checking or unchecking this option affects only the view in Catalog Explorer. Check this 
option if you wish the view of the catalog list in Catalog Explorer to be expanded down 
to the bottom of the entire program window. This is useful if you're working with a long 
list of catalogs and you want to see as many as possible at a glance. When this option is 
checked, the Search Result or Browse window will be hidden while Catalog Explorer is 
the selected program tab. You can maximize the Catalog list or restore it to normal size 
using this option, or use keyboard shortcut F7 (when in the Catalog Explorer tab). 

Notice: This option is unchecked by default, and is only useful if you are managing a 
long list of catalogs. For most purposes, we recommend that this option be kept 
unchecked, so that the Catalog Explorer Browse window can be seen, too.

Enable file checkboxes
Select this option if you want to be able to select multiple files by tagging checkboxes in 
the search result list, instead of using the traditional Windows CTRL + click method.

Notice that whenever file checkboxes are enabled, file operations will only be performed 
on file names that are currently tagged (checked). If you find this behavior confusing, 
you should keep this option unchecked. 

More information on File checkboxes

List file sizes as KB
SuperCat originally rounded off all file sizes to kilobytes (KB), as Windows Explorer 
does. In response to user requests for exact byte size for aiding comparison of files, 
SuperCat now offers exact byte size in its catalogs.

If checked, this option lists file sizes as kilobytes in all SuperCat Search Result and 
Browse windows. If this option is not selected, sizes in those windows are listed as exact 
byte sizes.

If you're not interested in exact byte size, or wish to retain compatibility with old 
catalogs (created with program versions prior to SuperCat 4.0), keep this option 
checked. However, it you wish to make the changeover to exact byte size in Result and 
Browse windows, particularly so you can decide if two identically named files are exactly 
the same or not, you should delete your old catalogs and re-create them with the List 
file sizes as KB option Unchecked.

Even with the List file sizes as KB option unchecked, there are some areas of SuperCat 
that will still show sizes in KB. In Catalog Explorer, disk sizes are listed in rounded-off 



MB (megabytes). 

Default icons only
Forces SuperCat to display only standard Windows icons in Search Result and Browse 
windows. Check this option for faster search results (especially when listing *.exe files). 
Some users have also reported problems with SuperCat trying to access non-accessible 
disks, such as removable media not presently inserted into their drives (especially 
running Windows NT or 2000). Using this option should fix all such problems. 

Colors
There are three dropdown lists for selecting Zipfile color, Image color, and Find 
duplicates alternate color. All three of these lists initially present you with 20 popular 
colors from which to choose. However, at the bottom of each dropdown list you can also 
click on Other, which displays a dialog box that allows you to choose any color.

Zipfile color
If you've enabled the Catalog zipfile content option before cataloging a disk, a 
subsequent search may include files actually contained inside a zip file. To alert you on 
the Result list to this fact, SuperCat allows you to specify a unique font color for such a 
file. (Note that the Browse window of Catalog explorer will never show files contained 
inside zip files--only the search Result window will show such files if you've opted to 
catalog them and specifically searched for and found them.) You can select any font 
color to display files that were found inside zip files.

Image color
Image files that are supported by ImageCat are displayed with a unique font color. That 
way, when you see a file listed in this color on a Result list or in the Catalog Explorer 
Browser, you'll know you can single-click on it to show the image with ImageCat. The 
Image color dropdown list allows you to select whichever font color you'd like for 
supported image files. 

Image files that are shown in the Result list with the normal font color (black) aren't 
supported by SuperCat, and their font color will tell you they cannot be displayed by 
ImageCat. But you can double-click on unsupported image types and launch them for 
viewing by your system's default image viewer. 

Find duplicates alternate color
When you use the Find Duplicates feature of SuperCat, each set of identical filenames 
are displayed using an alternate background color. The first set of duplicate files (2 or 
more files) will be shown with your default Windows background color (usually white). 
The next set of duplicates will be shown with a highlighting color that is currently shown 
in the Find duplicates alternate color field. Note that this control only changes the 
highlighting, or background, color of alternate sets, but not the font color.

Some users may prefer a canary yellow highlighting of alternate sets on the list. Others 
may prefer a bolder, fluorescent green or other highlighting of alternate sets. SuperCat 
allows you to set the alternate color to whatever you prefer.

Font and size
Users with smaller screens or who cannot comfortably read SuperCat's default 10 pt 
font can change the font size for the Search Result and Catalog Explorer Browse 
windows. Such an adjustment may increase your enjoyment of SuperCat if you find 
yourself squinting to read file lists.



If you increase the font size, field widths may need adjustment. First, you can drag the 
right edge of the SuperCat window to the right to increase the width of the SuperCat 
window. You can also click on the maximize button of the SuperCat window. (There are, 
however, advantages to not maximizing Supercat.) Then, you can move the cursor to 
the column-label row of the Search Result and Browse windows, put the cursor over any 
of the short lines separating the columns, and drag a line left or right. In this way, you 
can adjust the column widths to accommodate the new font type and size. (SuperCat 
will remember window width and field widths between sessions.)

There are two fields for changing the font and size of Search Result and Catalog 
Explorer Browse windows. The Font field is a dropdown list which lists all of the fonts 
currently installed on your system. The size field allows you to increase or decrease the 
size of whatever font you choose.

Adjusting Font and Size
If you change the font type with the Search Result or Browse window closed, then you 
can look at a small sample of each font on the right side of the dropdown list for every 
font currently installed on your system. In the dropdown list, each font is shown in a 
small point size.

However, by all means, conduct a search before changing the font and size and leave 
the Search Result window open, before you go to the Options > Display dialog. That 
way, when you open Options > Display and make changes, you'll see instantaneous 
changes to the appearance of the open Result list, which will be partly showing 
underneath the dialog box. You'll be able to instantly see, while you're making changes, 
exactly how changes of font and size will really appear. It's strongly recommended that 
you try this procedure once so you can quickly set up a Result-list appearance that's 
best for you and the fonts installed on your system.



Options: Reports

See also: Reports

Options for the report editor and save results to file button.

Do not format output
File lists will not be formatted. Useful if you need to create reports for use in database 
programs, etc. When selecting this option, the Format as columns option will also be 
selected.

Separator for unformatted output
Select or enter any separator for unformatted reports.

Format as columns
Format reports as columns (default) or line by line. 

Truncate lines longer than 
The maximum length of file- and path names as displayed in the report editor or when 
saving results as hypertext documents. (Ignored when saving as semicolon-separated 
database files).

Include 
Select which fields will be included in your reports. 

HTML Table width 
Table width value

HTML Cellpadding
Cellpadding value

HTML Border
Include or exclude table border

HTML Include link
Check to include filename as link

HTML Use URL prefix
Set your own prefix to filenames, e.g. www.servername.com. This option is only 
enabled when Include link is checked.



Options: Autocomments and checksums

For many users, autocomments is one of the most appreciated features in 
SuperCat. Instead of adding your own file comments (descriptions) for hundreds, 
or even thousands of files, SuperCat can do this for you. Often, having created a 
catalog with autocomments enabled, it's much easier to find the files you're 
searching for. 

Using checksums (CRC's), it's easy to determine if files are identical, for example.

Use autocomments for these file types
To enable autocomments, make sure that Enable autocomments is checked when you create 
a new catalog. This will enable autocomments for all file types specified in the Options 
dialog (File > Options or shortcut F8). By default, only Zip archives and Hypertext 
documents are enabled.

These are the supported file types:

Zip archives: Extract and include comments from zip-files. File_id.diz, readme.txt or 
whatsnew.txt are read in that order.

Image files: Extract file information from the IPTC-header in *.tif, *.jpg and *.psd files. 

IPTC is an information standard developed by the Newspaper Association of America 
(NAA) and the International Press Telecommunications Council (IPTC) to identify 
transmitted text and images. The standard is supported by programs such as Adobe 
Photoshop and other advanced image editing and database software.

Hypertext documents: Use document titles found in hypertext <title></title> tag.

MPEG audio files: Extract title, artist, album title, year and comment from MPEG audio 
files.

EXE and DLL files: When available, extract descriptions from EXE and DLL files. 

Descript.ion: A standard format for file descriptions, as supported by 4DOS and other 
file utilities.

Notice: Using autocomments will decrease speed when creating or reindexing your 
catalogs. Only use autocomments when needed. For example, if you never use IPTC-
information in your image files, make sure the Image files option is unchecked.

Calculate CRC's for these file types
Enter file extensions that you want to calculate checksums for.

This will calculate a CRC32 value ("checksum") for all file types specified. The 
checksum(s) will be recorded in the catalog in the same manner as autocomments.

CRC stands for cyclic redundancy check. It is a calculation made from all the data in a 
file. CRC values can be used for many things, for example to verify if two files are 
identical or checking file integrity. For example, many image- and MP3-collectors use 



checksums to search for identical files, etc. 

The CRC-32 value calculated by SuperCat matches the one from programs like PKZIP 
and WinZip.

Add prefix "CRC:"
Checksums are included in your catalogs as file comments. Use this option if you want 
checksums to have a CRC: prefix in front of the actual CRC value.



Filters

Open the Filter editor by selecting File > Filters, or using keyboard shortcut F9.

You can easily change the default catalog and search filters, or add your own, using the 
Filter editor.

Text can be any descriptive text, but file types must be of the format: *.ext1; *.ext2; 
*.ext3, etc., with semicolons between each extension (if more than one) listed for a 
particular filter.
 

For example: *.gif;*.jpg;*.htm;*.html

Click the Default button to restore the default filters.

Read the article entitled Filter Dropdown List contained in the Search topic in this Help 
file.



Register

See also: License agreement

If you want to use SuperCat beyond the 30-day trial period, you must register. You 
can register online, by phone, fax, mail, purchase order, or direct bank transfer. 
And remember, all future upgrades are free. 

ONLINE REGISTRATION
The easiest way to register SuperCat is by using our online registration service (Internet 
connection required).

BY PHONE
(9.30 am to 4.30 pm PST)
Toll Free: (877) 353-7297 (US only)
Regular: (425) 392-2294 

For all offline orders, use this printable order form

PURCHASE ORDERS
A purchase order must be faxed or mailed (use number or address below), with all 
necessary information, including billing information. Most companies that choose to use 
the purchase-order option have a standard form that they use for making these types of 
orders. 

BY FAX
Send the order form to one of these numbers:
Toll Free: (888) 353-7276 (US only)
Regular: (425) 392-0223 

BY MAIL
Make checks payable to Register Now!, including the SuperCat ID (1176-1 for single-
user licenses) on the "memo" of the check. Send the order form and your check to: 

Register Now!
ATTN: Orders
PO Box 1816
Issaquah, WA 98029
USA 
(Please, do not send Eurochecks.) 

DIRECT BANK TRANSFER
An alternative method of paying is to have the money transferred directly to our bank 
account. 

To cover our expenses, please notice that the price for a single-user license is 
$30 (US) when using this option. 

Swift: FOKBNO22
Bank Name: Fokus Bank



Bank Address: N-7005 Trondheim, Norway
Bank Account: 8601.03.67346
Name: No Nonsense Software
Product: SuperCat
Amount: USD 30 for a single-user license (or the equivalent in your local currency) 

We will process your order immediately when we receive a notice of your payment from 
our bank. Registration information will be sent to your email address. We also 
recommend that you send us an email, so that we can look out for your order. 



Order form

SuperCat order form (single-user licenses only)
===================================
Print and use this form if you want to register SuperCat by mail or fax. 

For other registration alternatives (online credit-card registration, phone, purchase order, or 
direct bank transfer), visit our website at http://no-nonsense-software.com for more 
information.

Please notice that we do not accept any Eurochecks.

Make checks payable to Register Now!, including "product ID 1176-1" on the "memo" of the 
check. 

For mail orders, send this form and your check to:

Register Now!
ATTN: Orders
PO Box 1816
Issaquah, WA 98029 
USA

Send your fax order to: (888) 353-7276 (Toll Free, US only) or (425) 392-0223 

Your name: ______________________________________

Your address: ____________________________________

Phone: __________________________________________

Email address: ____________________________________

Credit card, e.g. Visa, Mastercard (fax orders only): _______________

Credit card number (fax orders only): ___________________________

Credit card expiration date (fax orders only): _____________________

Number of licenses: _______

Total payment (number of licenses x 25 + $2,50 s/h) = USD _________



SuperCat is distributed by electronic delivery only. When we receive and confirm your order, 
we will send you download instructions by e-mail.



ImageCat

ImageCat is a handy image viewer, allowing you to preview common image file 
formats from within SuperCat. Using one of the fastest image display engines 
available, browsing your images has never been easier.

You can enable or disable ImageCat by Selecting View > Image Preview from the main 
program menu (or use keyboard shortcut CTRL + Backspace). ImageCat is enabled by 
default.

· Supported image file formats will be listed in the search result listview in a special 
color (which can be selected under Options > Display).

· The supported file formats are: .jpg .tif .gif .bmp .emf .pcx .png .dib .tga
· When enabled, selecting any supported image file from the search result listview, will 

automatically display the image
· Images can be viewed with ImageCat in Docked or Floating mode. Select mode by 

checking or unchecking the Floating option in ImageCat. If ImageCat is the active 
window (Floating mode only), you can navigate the file list by using up and down 
arrows. Pressing the PageUp and PageDn keys will advance through the Result list by 
windowfuls.

· Check the Auto hide option to automatically close ImageCat whenever an unsupported 
file format is selected in the file list

· Size images by selecting Shrink to fit or Full size
· Use the right-click pop-up menu for more options (zoom, rotate, etc.)
· Use the ESC key to close the image preview window
· Double-click on the program status bar or use keyboard shortcut ALT + Backspace to 

toggle image preview on/off

Set desktop wallpaper
Click the Desktop wallpaper control to set the currently displayed image as your desktop 
wallpaper. Clicking on the downarrow button at the right-side of this control allows you 
to choose centered, tiled, or stretched display of the wallpaper image.

Print your images
Click the Print button to print the image currently displayed. 

The print will include the path and filename at the top of the page above the image. The 
print routine will scale the image to fit (fill) the currently selected paper size (if set by 
Windows) for the currently selected printer.




